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Drawing Annotation Toolbar

The Drawing Annotation Toolbar can be accessed through the View->Toolbar menu.

Pressing on the top of the Panel Bar and selecting it can also activate the Drawing Annotation toolbar.
Using this method will retire the Drawing Management Panel bar.

You can also access any toolbar by right clicking on the standard toolbar at the top of the screen.
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This toolbar contains tools that add annotations to a drawing.  It is divided into four sections:  Dimension,
Symbol, Text, and Parts List tools.

•  Dimension tools add general drawing dimensions and ordinate dimensions to a selected element.

•  The center mark tools add center marks, center lines, center line bisectors, and centered patterns to
a drawing.

•  The symbols tools add a variety of GDT and other symbols to a drawing.

•  The text tools add notes to a drawing.

•  Parts list and balloon tools add those annotations to a drawing.

General Dimension

Use the General Dimension button on the Drawing Annotation toolbar to add drawing dimensions to a
view. Drawing dimensions do not affect the size of the part, but they provide documentation in the
drawing.

1. Click the General Dimension button.

2. In the graphics window, select the geometry and drag to display the dimension.

o To add a linear dimension for a line or edge, click to select the geometry.

o To add a linear dimension between two points, two curves, or a curve and a point, click to
select each point or curve.

o To add a radial or diametric dimension, click to select an arc or circle.

o To add an angular dimension, select two curves.

o To add an implied intersection dimension, select two curves to define the intersection,
right-click and select Intersection, then select the element to dimension.

3. Click to place the dimension in the desired location.

As you develop a drawing, you can use two types of dimensions to document your model.  Model
dimensions are the dimensions that control the feature size in the part. They were applied during the
sketching or creation of the feature. In a drawing view, you can display model dimensions that are planar to
the view.

Drawing dimensions are dimensions that you add to further document the model. Drawing dimensions do
not change or control features or part size. You can add drawing dimensions as annotations to drawing
views or geometry in drawing sketches.

Modifying a drawing dimension in the Drawing Layout WILL NOT update the Model.  However, if you
change the model dimension it will update in the Drawing Layout and in the Model.
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If you set the option to edit model dimensions from a drawing when you installed Autodesk Inventor, you
can change the model dimensions in the drawing. Changes in the drawing should be reserved for minor
changes to individual dimensions. If significant changes or changes involving dependent features are
required, it is strongly recommended that they be made in the part model. You cannot make changes to a
part in an assembly view.  To edit the model, you must open the part file (*.ipt) and make the changes.  If
you close your drawing file, your drawing views will automatically update after you save the part file when
you re-open the file.  If you keep your drawing file open while modifying the part file, your drawing views
will not update until you save the part file and then use the Update button.

If you change the size of a part that has multiple occurrences in an assembly or is used in multiple
assemblies, all occurrences of the part change.

The ‘Edit Model Dimension’ will only be available on the menu if you selected that option when you
installed Inventor.

The Ordinate Dimension is actually a flyout with two options available:  Ordinate Dimension Set and
Ordinate Dimension.
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Ordinate Dimension Set

Use the Ordinate Dimension button on the Drawing Annotation toolbar to add ordinate dimensions.
This tool links all the dimensions placed as a group.  The first point selected is automatically assumed to be
the origin.  You must place all the dimensions along one axis, right click and select ‘Create’.  Then repeat
to place dimensions along the other axis.

The dimensions automatically align and adjust to avoid interference as you place them.

1. Click the Ordinate Dimension Set button.

2. In the graphics window, click to set the datum for the first dimension.

3. Position the cursor and click to place the first dimension value.

4. Continue selecting points and placing dimensions.

5. To change options for the dimension set, right-click at any time and select options.

6. To end the operation, right-click and select Create.

To modify ordinate dimensions, select the dimension set in the graphics window and right-click to display
the menu.   You have to option to reset the Origin, Add or Delete a dimension.

The first point picked when placing an ordinate dimension is automatically assigned the 0 value.  Place all
the dimensions desired for that axis (whether horizontal or vertical), then right click to select Create.
Then place the dimensions for the other axis.

Pressing ‘O’ on the keyboard will also initiate the Ordinate dimension command.



Drawing Annotation

Page 19-5

Ordinate Dimension

The Ordinate Dimension Set tool places multiple ordinate dimensions along a single axis.  The Ordinate
Dimension tool allows the user to place one or more dimensions on one or more axis.

The other difference between the tools is that ordinate dimensions placed with the Ordinate Dimension Set
are considered a group so if you delete one dimension in the set, you delete all the dimensions along the
same axis in that set.  Dimensions placed with the Ordinate Dimension tool are considered independent of
all the other ordinate dimensions along the same axis.

The Ordinate Dimension tool also requires that the user identify the origin of the part before any ordinate
dimensions are placed.

The tool places a marker at the origin point.

To hide the marker, select it, right click and select ‘Hide Origin Indicator’.



Drawing Annotation

Page 19-6

Hole/Thread Notes

Use the Hole Notes button on the Drawing Annotation toolbar to add a hole or thread note with a leader
line. The text, style, color, and line weight for the notes are determined by the active drafting standard.

1. Click the Hole Notes button.

2. In the graphics window, click to select the hole.

3. Move the cursor and click to place the note.

4. When you are finished placing hole notes, right-click and select Done.

 Center Mark
There are four types of center markings that you can add to a drawing view; center marks, center line
bisectors, center lines, and centered patterns. To choose a center marking option, click the arrow next to the
active center marking button, and select from the pop-up menu.

1. Click the Center Mark button.

2. In the graphics window, click a feature to place a center mark.

3. Continue selecting features to place center marks.

4. Right-click and select Done to terminate the operation.

1. Select the center mark to edit.

Hole notes can be added only to hole features created using the Hole feature tool in parts.
To edit the Hole Note, select, right-click and select ‘Text’.

Pressing ‘C’ on the keyboard will also activate the Center Mark command.
This is a pull-down with other options available.
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2. Right-click and select Edit to display the submenu.

3. Select the desired option.

The Center Mark Standards are accessed under Format->Standards in the menu.

Mark Sets the size of the center indicator mark.
Gap Sets the gap distance between the center indicator and the extension line.
Extension Sets the minimum length of center mark extension lines.

Overshoot Sets the distance that center mark extension lines extend beyond the edges of the features
that they define.

Fictitious
Diameter Sets the size of center marks for suppressed pattern features.

You can lengthen or shorten an extension line for any center line or center mark by dragging its endpoint.
In addition, you can edit center marks in the several ways.
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Center Line

1. Click the Center Line button.

2. In the graphics window, click a feature to start the center line.

3. Click a second feature to add the center line.

4. Continue selecting features until all desired features are added.

5. Right-click and select Done to accept the displayed center line. The operation remains active so
that you can add other center lines.

Center Line Bisector

1. Click the Center Line Bisector button.

2. In the graphics window, click two lines to place the center line bisector between them.

3. Right-click and select Done to accept the displayed center line. The operation remains active so
that you can add other center line bisectors.

TIP:  If the features form a circular pattern, the center mark for the pattern is automatically placed when
you have selected all of the members.
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Centered Pattern
1. Click the Centered Pattern button.

2. In the graphics window, click the defining feature for the pattern to place its center mark.

3. Click the first feature of the pattern.

4. Continue clicking features in a clockwise direction until all desired features are added.

5. Right-click and select Done to accept the displayed centered pattern. The operation remains active
so that you can add other centered patterns.

TIP:   No center line is added between the final feature in the pattern and the beginning feature. You can
manually extend the line if needed.
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Surface Texture Symbol

Specifies the content of a surface texture symbol. The options in the dialog box are determined by the
active drafting
The symbols can be created as stand-alone objects, be placed directly on the geometry in a drawing view, or
reside on top of a leader line which points to the geometry. Surface Texture Symbols may also be used in
notes and in the tolerance block.

Surface Type

Click a button to select the desired surface type.

Basic

Material removal required

Material removal prohibited

Miscellaneous

Specifies the general attributes of the symbol. Click the button to add or remove each attribute.

Force tail adds a tail to the symbol.

Majority indicates that this symbol specifies the standard surface characteristics for the drawing.

All-around adds the all-around indicator to the symbol.

Surface
characteristics

Defines the values for the surface characteristics. Enter the appropriate values in the boxes.
A specifies the roughness value, roughness value Ra minimum, minimum roughness value, or grade number.
A' specifies the roughness value, roughness value Ra maximum, maximum roughness value, or grade number.
Available only when A has an entered value.
B specifies the production method, treatment, or coating. If the active drafting standard is based on ANSI, this box
can be used to enter a note callout.
B' specifies an additional tail for the production method if the drafting standard is based on ISO or DIN. This
option is available only when B has an entered value.
C for ANSI, specifies the roughness cutoff or sampling length for roughness average; for ISO or DIN, specifies the
waviness height or sampling length; for JIS, specifies the cutoff value and evaluation length.
C' for ANSI, specifies the roughness cutoff or sampling length for additional roughness value; for ISO or DIN,
specifies the sampling length for additional roughness value; for JIS, specifies the reference length and evaluation
length.
D specifies the direction of lay. Click the arrow and choose the symbol from the list. This option is not available
when the removal prohibited option is selected.
E Not available when the Machining Removal Prohibited is selected. Specifies the machining allowance.
F specifies the roughness value other than Ra or the parameter value other than Ra. For ANSI, can also specify the
waviness height.
F' specifies the surface waviness for JIS. This option is not used for ANSI, ISO, or DIN standards.

The user picks points to place the symbol.  The first point selected indicates the location of the arrowhead.
The user can then select any number of points to control the placement of the leader and symbol.  When
finished, right click and select ‘Continue’.  Selecting ‘Done’ is equivalent to canceling out the command.
Selecting ‘Back up’ allows the user to back up one selected point and select a new point.  (similar to the
Undo command in AutoCAD)
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1. Click the Surface Texture Symbol button.

2. In the graphics window, click to set the start point for the leader line. When the symbol indicator
is in the desired position, right-click and choose Continue to place the symbol and open the dialog
box. Set the attributes and values for the symbol.

Continue placing surface texture symbols. When you finish placing symbols, right-click and select ‘Done’
from the menu to end the operation.

The Surface Texture Symbols are controlled in the Standards dialog box under the Surface Texture tab.

TIPS:  To place a symbol without a leader, double-click to set the symbol location and open the dialog
box.

The options in the dialog box are determined by the active drafting standard.

If you place the first point on a highlighted edge or point, the leader line is attached to the geometry.

If you turn off a symbol in the Standards dialog that is already used in a drawing, the existing symbols
will continue to display, but the symbol will not be available when new symbols are added.



Drawing Annotation

Page 19-12

Moving your mouse over the dialog box will bring up a help tip to assist in filling out the dialog box.

To edit an existing symbol:
1. Activate the select tool
2. Pick the symbol to edit.You should see green grips activate.Right click and select the editing mode

desired.

Selecting the Edit Arrowhead option will bring up a dialog where the user can select the current standard or
a different arrowhead.

Selecting the ‘Add Segment or Vertex option’ activates the Grip mode and the user can use the mouse to
stretch or modify the leader for the symbol.
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Weld Symbol

Specifies the content of a welding symbol. The dialog box opens when you place a welding symbol. The
options available are determined by the active drafting standard.

The General Tab sets the components and layout of the welding symbol.

Orientation

Sets the orientation for the components of the welding symbol. Click the button to set the desired orientation for each
component.

♦  Swap arrow side reverses the arrow side and other side for the selected reference line.
♦  Identification line Available for ISO and DIN only. Sets the location of the identification line to the arrow

side or the other side for the selected reference line.
♦  Left/right orientation sets the location of the reference line relative to the leader line.

Stagger Staggers the welding symbols for fillets. Available only if fillet welding symbols are set on both sides of the reference
line.

Symbol

♦  Selects, adds, or deletes reference lines on the welding symbol.
♦  Add adds a reference line to the symbol. The selected reference line is moved toward the arrowhead and the

new line is added further from the arrowhead than the selected reference line. You can set the orientation and
other attributes for the new reference line.

♦  Delete removes the selected reference line from the symbol.
♦  Previous selects the next reference line away from the arrowhead.
♦  Next selects the next reference line toward the arrowhead.

Note Adds text to the selected reference line. Enter the text in the box.
Arrow side Opens the Arrow Side options so that you can set the symbol and values for the selected reference line.
Other side Opens the Other Side options so that you can set the symbol and values for the selected reference line.

Flag Specifies whether to add a flag indicating a field or site weld to the selected reference line. Click the button to turn the
flag off or on.

All-around
symbol

Specifies whether to use an all-around symbol on the selected reference line. Click the button to turn the symbol off or
on.
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The Arrow Side tab sets the symbols and defines the values for each side of the welding symbol. The
available options change, depending on the specified weld type and the active drafting standard. Choose the
weld type and secondary fillet type, if applicable, then specify the corresponding attributes.
Secondary fillet
type

Specifies the type of weld for secondary fillets. Click the button to display and choose from the palette of available
weld types. This button is available only when the active drafting standard is based on ANSI.

Angle Specifies the angle between weldments.
Brazing Specifies whether the weld is brazed. Select or clear the check box to add or remove the brazing symbol.
Clearance Specifies the clearance for the braze.
Contour Specifies the contour finish for the weld. Click the arrow and choose the contour from the list.
Depth Specifies the depth of the weld.
Diameter Specifies the diameter of the weld.
Gap Specifies the space between weldments.
Height Specifies the height of the weld.
Length Specifies the length of the weld.
Method Specifies the finish method for the weld. Click the arrow and choose the method from the list.
Middle Specifies the type of inspection to perform on the weld.
Number Specifies the number of welds.
Pitch Specifies the distance between welds.
Root Specifies the root thickness of the weld.
Root gap Specifies the gap for the weld.
Size Specifies the size of the weld.
Small leg Specifies the thickness of the weld.
Spacing Specifies the space between welds.
Thickness Specifies the thickness of the weld.
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Weld
type

Specifies the type of weld. Click the button to display and choose from the palette of available weld
types. The weld types displayed on the palette are determined by the active drafting standard.

To place the symbol:

1. Click the Welding Symbol button.

2. In the graphics window, click to set the start point for the leader line.

3. When the symbol indicator is in the desired position, right-click and select Continue to place the
symbol and open the Welding Symbol dialog box. The options in the dialog box are determined by
the active drafting standard.

4. Set the attributes and values for the symbol.

Continue placing welding symbols. When you finish placing symbols, right-click and select ‘Done’ from
the menu to end the operation.

TIPS:  Running your mouse over the buttons without clicking will reveal a help indicating what each
symbol represents.

To add or remove symbols from the palette, customize the drafting standard.

To associate the welding symbol with geometry, move the cursor over the desired edge and click when
the edge highlights. Symbols that are associated with geometry will move if you move the drawing view.

Move the cursor and click to add a vertex to the leader line.

The line type, line weight, color, and gap for the symbol are determined by the active drafting standard.
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To edit an existing symbol:
1. Activate the select tool
2. Pick the symbol to edit. You should see green grips activate.Right click and select the editing

mode desired.

Selecting the Edit Arrowhead option will bring up a dialog where the user can select the current standard or
a different arrowhead.

Selecting the ‘Add Segment or Vertex option’ activates the Grip mode and the user can use the mouse to
stretch or modify the leader for the symbol.
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 Feature Control Frame

Specifies the content of a feature control frame. The options in the dialog box are determined by the active
drafting

Sym Specifies the tolerance symbol. Click the button to open the symbol palette and select the
desired symbol. The symbols on the palette are determined by the active drafting standard.

Tolerance
Sets the tolerance values.
Tolerance 1 specifies the tolerance.
Tolerance 2 specifies the lower tolerance (ANSI standard only).

Datum Specifies the datums that affect the tolerance.
Insert modifier
buttons

Adds modifier characters to the text at the insertion point. Click a button to add the desired
character. The available characters are determined by the active drafting standard.

All Around Adds an all-around character next to the feature control frame. Select the check box to add
the character; clear the check box to remove it.

1. Click the Feature Control Frame button.
2. In the graphics window, click to set the start point for the leader line. If you place the point on a

highlighted edge or point, the leader line is attached to the geometry. If you are creating a leader
line, move the cursor and click to add a vertex to the leader line.

3. When the symbol indicator is in the desired position, right-click and select ‘Continue’ to place the
symbol and open the dialog box. The options in the dialog box are determined by the active
drafting standard.

4. Enter the information for the symbol and close the dialog box.

Continue placing feature control frames. When you finish placing symbols, right-click and choose ‘Done’
from the menu to end the operation.

TIPS:
The text boxes in the second row are available only if you select a tolerance-type symbol for the row. You
can specify in the active drafting standard whether to merge corresponding fields when the information is
the same.

You can create a feature control frame with a leader line or as a stand-alone symbol. The color and line
weight of the symbol are determined by the active drafting standard.

To place a symbol without a leader, double-click to set the symbol location and open the dialog box.
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Feature Identifier Symbol

NOTE:  This tool is NOT available in ANSI standard mode.  To access this symbol, go to
Format-Standards and select ISO, DIN, or JIS.

Use the Feature Identifier button on the Drawing Annotation toolbar to create a feature identifier symbol
with a leader line. The color and line weight of the symbol are determined by the active drafting standard.

1. Click the Feature Identifier button.
2. In the graphics window, click to set the start point for the leader line.
3. Move the cursor and click to add a vertex to the leader line. You can only add one vertex.

4. When the symbol indicator is in the desired position, click to place the symbol and open the Value
dialog box.

5. Enter the appropriate label for the symbol and then click the check mark to close the dialog box.

Continue placing feature identifier symbols. When you finish placing symbols, right-click and select Done
from the menu to end the command.

To edit an existing symbol:
1. Activate the select tool
2. Pick the symbol to edit. You should see green grips activate.Right click and select the editing

mode desired.

Selecting the Edit Arrowhead option will bring up a dialog where the user can select the current standard or
a different arrowhead.

Selecting the ‘Add Segment or Vertex option’ activates the Grip mode and the user can use the mouse to
stretch or modify the leader for the symbol.
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Datum Identifier Symbol

Use the Datum Identifier button on the Drawing Annotation toolbar to create one or more datum identifier
symbols. You can create a datum identifier with a leader line or as a stand-alone symbol. The color and line
weight of the symbol are determined by the active drafting standard.

1. Click the Datum Identifier button.

2. In the graphics window, click to indicate the start point for the leader line or double-click to place
a symbol without a leader. If you place the point on a highlighted edge or point, the leader line is
attached to the geometry.

3. If you are creating a leader line, move the cursor and click to add a vertex to the leader line. You
can only add one vertex.

4. When the symbol indicator is in the desired position, click to place the symbol and open the Value
dialog box.

5. Enter the appropriate label for the symbol and then click the check mark to close the dialog box.

Continue placing datum identifier symbols. When you finish placing symbols, right-click and choose
‘Done’ from the menu to end the operation.
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Datum Target

Click the arrow next to the Datum Target Symbol button and choose the datum target type from the pop-up
menu.

Dimension Specifies size of the target area. Enter the number.
Datum Specifies the label for the target.

Target types are Leader, Line, Rectangle, Circle, and Point.
1. Click the arrow next to the Datum Target button.

2. Select the target style from the palette.

3. In the graphic window, click to set the start point for the datum.

o Leader datum start point sets the terminator for the leader line.

o Line datum start point sets one end of the datum line. Click to set the other end.

o Rectangle datum start point sets the center of the rectangle. Click again to define the area.

o Circle datum start point sets the center of the circle area. Click to again to define the area.

o Point datum start point places the point indicator.

4. Move the cursor and click to add a vertex to the leader line.

5. When the symbol indicator is in the desired position, right-click and choose Continue to place the
symbol and open the Datum Target dialog box.

Enter the appropriate dimension value and datum for the symbol

Continue placing datum target symbols. When you finish placing symbols, right-click and choose ‘Done’
from the menu to end the operation.

TIPS:
To stack datum targets, right-click an existing datum target and select Attach Balloon from the menu.

The color, target size, and line weight of the symbol are determined by the active drafting standard.
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To edit an existing symbol:
1. Activate the select tool
2. Pick the symbol to edit.You should see green grips activate.4. Right click and select the editing mode desired.

Selecting the Edit Arrowhead option will bring up a dialog where the user can select the current standard or
a different arrowhead.

Selecting the ‘Add Segment or Vertex option’ activates the Grip mode and the user can use the mouse to
stretch or modify the leader for the symbol.

To stack datum targets, select Attach Balloon from the menu.

Selecting ‘Hidden Leader Line’ changes the linetype of the leader to Hidden.

If you have stacked datum targets and need to make modifications, the right click menu adapts to give you
the option of editing different targets.
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Text

Use the Text button on the Drawing Annotation toolbar to add general notes to a drawing. General notes
are not attached to a view, symbol, or other object in the drawing.

1. Click the Text button.

2. Use one of the following methods to define the text box:

o Click to place the top-left corner of the text box. When you enter the note, the width of
the box adjusts to the longest line of text.

o Drag to define the area of the text box. When you enter the note, the text wraps within the
defined width of the box.

3. Enter the text at the blinking insertion point. You can click to reposition the insertion point relative
to previously entered text.

o To add a symbol to the text, click the symbol button in the Text dialog box and select the
symbol from the palette.

o To add a named parameter from the model file to the text, specify the source and
parameter name, then click the Add Parameter button.

o To change the formatting, select the text then choose the formatting options.
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To modify a general note, select it in the graphics window, right-click, and select the operation from the
menu.

•  To copy the note, select copy. You can paste the text to another place on the drawing sheet, to a
different sheet in the same drawing, or to a sheet in another drawing.

•  To remove the note, select Delete.

•  To edit or format the existing text, select Edit Text to open the Format Text dialog box.

•  To rotate the note, select the desired rotate direction.

Leader Text

Use the Leader Text button on the Drawing Annotation toolbar to add notes with leader lines to a drawing.

1. Click the Leader Text button.

2. In the graphics window, click to set the starting point for the leader line. If you place the point on a
highlighted view, the leader line is attached to the view.

3. Use one of the following methods to define the text box:

o Click to place the top-left corner of the text box. When you enter the note, the width of
the box adjusts to the longest line of text.

o Drag to define the area of the text box. When you enter the note, the text wraps within the
defined width of the box.

4. Enter the text at the blinking insertion point. You can click to reposition the insertion point relative
to previously entered text.

o To add a symbol to the text, click the symbol button in the Text dialog box and select the
symbol from the palette.

TIPS:
The default text format is controlled by the active drafting standard. To change the default text for a
drawing or template, modify the drafting standard.  Go to Format->Standards and select the Common tab.
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o To add a named parameter from the model file to the text, specify the source and
parameter name, then click the Add Parameter button.

o To change the formatting, select the text then choose the formatting options.

To modify a note, select it in the graphics window, right-click, and select the operation from the menu.

•  To remove the note, select Delete.

•  To edit or format the existing text, select Edit Text to open the Format Text dialog box.

•  To change the arrowhead or other terminator, select Edit Arrowhead and select the new terminator
from the dialog box.

•  To add a point to the leader line, select Add Segment or Vertex, then click in the graphics window
to place the point. You can drag the added point to redefine the leader line.

Balloon/ Balloon All

Use the desired Balloon button (Balloon/Balloon All) on the Drawing Annotation toolbar to add reference
balloons to a drawing.

To add a balloon to an individual part (Balloon):

1. Click the Balloon button.

2. In the graphics window, select the part and then click to set the start point for the leader line.

3. Move the cursor and click to add a vertex.

TIPS:

If you attach a note leader line to a view or to geometry within a view, the note is moved or deleted when
the view is moved or deleted.

The active drafting standard controls the default text format. To change the default text for a drawing or
template, modify the drafting standard.  Go to Format->Standards and select the Common tab.
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4. When the symbol indicator is in the desired position, right-click and choose Continue to place the
symbol. The symbol style is determined by the active drafting standard.

Continue placing balloons. When you finish placing balloons, right-click and select Done from the menu to
end the operation.
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To add balloons to all the parts in a view:

1. Click the arrow next to the Balloon button and select Balloon All.

2. In the graphics window, select the view.

Editing Balloons:

The default style for balloons is defined by the active drafting standard. After placing a balloon, you can
change the arrowhead style, attach or remove additional balloons, or add segments to the leader line.

To remove a balloon from a stacked set, right-click the balloon and select ‘Remove Balloon’ from the
menu. If there are several attached balloons, the last balloon to be attached is removed first.

A balloon can contain the item number of a first-level component in the assembly, or of an individual part,
depending on the setting in the active drafting standard. You can change the level of the item number in a
balloon.

To change the Level of a balloon reference, right-click the balloon and select Part to show the item number
for the part to which the balloon is attached, or First-Level Component to show the item number for the
subassembly that contains the part.

TIPS:

A first-level component can be either a subassembly or a part.

If you add balloons to a drawing before creating a parts list, the balloons will show the item numbers of first-
level components. You can select a balloon and change it to show the item number of the part to which it is
attached.

Typing ‘B’ will initiate the Balloon command.
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Parts List

Adds a parts list for the components of the assembly in the selected view.

Sets the number of levels of components to include in the parts list. Select the desired level.

First-Level Components
Creates a parts list that shows only the top level of components of the assembly in
the selected view. Subassemblies and parts that are not part of a subassembly are
shown, but not the parts in the subassemblies.

Only Parts Creates a parts list that shows the parts of the assembly in the selected view.
Subassemblies are not shown, but the parts in the subassemblies are shown.

Set the scope of parts list to include all or a range of components of the assembly in the selected view when
the Level is set to Only Parts. Not available when First-Level Components is selected.
All Creates a parts list for all the components in the selected view.

Items
Creates a parts list for the specified range of parts. Select Items then enter the part
numbers, separated by commas, or click the parts in the graphics window to include
them in the list.

The Parts List format is set in the Drafting Standards dialog box.  Access by selecting Format->Standards.
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Spreadsheet displays the content and setup of the selected parts list. As you perform operations or change column
properties, the changes are reflected in the spreadsheet. Items that have corresponding balloons are marked with a
balloon symbol.

If you compare the parts list to the current properties for the parts (click the Compare button), the values that are
inconsistent are highlighted in the spreadsheet. To resolve, right-click a highlighted cell and select the desired
resolution from the menu.

Update Value Changes the value in the selected cell to match the value in the part properties.
Update All Changes the values for all the highlighted cells to match the values in the part properties.
Keep Value Keeps the value in the selected cell, even though it diverges from the value in the part properties.

Keep All Keeps the values of all the highlighted cells, even though they diverge from the values in the part
properties

Parts List Operations performs operations on the selected parts list. Click the appropriate button to perform the
operation.

Compare checks the values in the selected parts list against the current properties values for the parts. If
the values differ, the corresponding cells in the spreadsheet are highlighted.
Column Chooser opens the Column Chooser dialog box so that you can add, remove, or change the order
of the columns for the selected parts list.
Sort opens the Sort Parts List dialog box so that you can change the sort order for items in the select
parts list.
Export opens the Export Parts List dialog box so that you can save the selected parts list to an external
file.
Heading opens the Heading Parts List dialog box so that you can change the title text or heading location
for the selected parts list.

TIPS:
To change the default heading location and title text for parts lists, use Format>Standards>Parts List to change the
attributes of the active drafting standard.
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Custom Parts adds non-graphic parts such as adhesives and lubricants to the parts list.
Adds a row to the parts list and renumbers the items in the list. Click the Add button to add the
row, then enter the part information.
Removes a custom part row from the parts list and renumbers the items in the list. Select the row
to remove, then click the Delete button.

Column Properties sets the width and alignment for the columns in the selected parts list.
Name Displays the name of the selected column.
Width Sets the width of the selected column. Enter the width in the box.
Name
Alignment Sets the alignment for the column title. Click a button to select left, center, or right alignment.

Data
Alignment

Sets the alignment for the data in the column. Click a button to select left, center, or right
alignment.

When a parts list is placed, its setup is determined by the settings in the active drafting standard. You can
modify the settings for a parts list after placing it.

1. Select the parts list in the graphics window or from the browser.

2. Right-click and select Edit Parts List from the menu.

3. Click the appropriate button in the dialog box to perform any of the following operations:

o Compare parts list values with part properties

o Change the columns that display in the parts list

o Change the sort order of the parts list

o Export parts list data to an external file

o Change the title name or heading location for the parts list

o Change the name of the column heading

o Add custom parts to the parts list

4. Click the More button to display and change column properties.

Changing the Heading Location or Title of a Parts List

    

To change the location of the Parts List Heading, right click on the Parts List, and select ‘Edit Parts List’.
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Select the Heading button in the dialog box.

This brings up another dialog where the user can set the location or change the title of the Parts List.
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Drawing AnnotationTools
Button Tool Function Special Instructions

General Dimension Creates a dimension between two points,
lines, or curves.

Double click on a
dimension to edit.

Ordinate Dimension Set Places a set of ordinate dimensions along
an axis.  The first dimension placed is
automatically assumed to be the origin
dimension.

To edit, select then right
click to access the edit
options

Ordinate Dimension Creates an ordinate dimension Requires the user to
select an Origin prior to
placing the dimension

Hole/Thread Notes Adds a hole or thread note with leader Hole notes can only be
added to features created
with the Hole tool.

Center Mark Creates a center mark Style of center mark is
set up in Drafting
Standards under Format

Center Line Creates a center line Right click to get
assistance in placing the
line

Center line Bisector Creates an angle bisector Select two lines to bisect

Centered Pattern Creates a centerline for a circular pattern
Surface Texture
Symbol

Creates a surface texture symbol Some options not
available in ANSI mode.

Weld Symbol Creates a weld symbol Drafting Standards
control the linetype,
color, and gap

Feature Control Frame Creates a feature control symbol Typing F can be used to
initiate this command

Feature Identifier
Symbol

Creates a feature identifier symbol NOT available in ANSI
standard mode

Datum Identifier
Symbol

Creates a datum identifier symbol

Datum Targets Datum Target with leader
Datum Target with circle

Datum Target with line

Datum Target with point

Datum Target with rectangle

Text Creates a text block Similar to MTEXT

Leader text Creates text with a leader attached.

Add balloon Adds a reference balloon Inventor assigns the
reference numbers to
parts automatically

Balloon All Adds balloons to all the parts in a view

Parts List Creates a parts list Customize the parts list
using property fields
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Review Questions

1. True or False

You can select and delete only one ordinate dimension created using the Ordinate Dimension Set
tool.

2. True or False

When placing ordinate dimensions using the Ordinate Dimension Set tool, you can switch
between the two axes – that is, place a dimension along the x-axis, place a dimension along the y-
axis, then place a dimension along the x-axis.

3. True or False

You can not hide the Origin Indicator placed with the Ordinate Dimension tool.

4. True or False

Inventor only has one style of Datum Target.

5. To modify a linear dimension:

A. Select the dimension, right click and select ‘Edit Dimension’

B. Select Edit from the Menu.

C. Double click on the dimension

D. Right click in the graphics window and select ‘Edit Dimension’.
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